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Media Management 

Pyramixは、Media Drives/Folders および Librariesの概念を利用した管理ツール「Media Management」を

提供します。 
  

オーディション再生 
Media Management画面に表示されるマスター・クリップやライブラリー画面のオーディオ・オブジェクトは、

Monitorセクションを介してオーディション再生することができます。 
任意のオブジェクトを選択して、ツール・バー上のPlay/Stopアイコンやスペース・バー/ESCキーを使用すると、オ

ーディション再生/停止が行えます。オーディション再生中にオブジェクトをダブルクリックすること、再度スタート・ポ

イントから再生できます。 
 

メディア・フォルダ 
Media Folderは、Mediaファイルを含んだハードディスク上のドライブもしくはフォルダを指します。 
PyramixからMediaファイルへアクセスするには、Media Folderをマウントする必要があります。 
Media Folderをマウントすると、Mono，Stereo，マルチチャンネルなどのMasterクリップが一覧表示されます。 
これらは、フォーマットの種類，サンプリング・レート，ビット深に関わらず、ドラッグ＆ドロップまたはコピー＆ペース

ト操作でタイムライン上への貼り付けやUserライブラリーへ保存が可能です。 
 

ターゲット設定 
Project > New または Project > New From Template からプロジェクトを新規作成する時に指定したメディ

ア・フォルダは、下記の場所においてもターゲットとして設定されます。 
z Project Information: Project Media Folder 
z Project Settings > Record設定    Target Settings > Media Folder 
z Project > Renderメニュー      Target Settings > Media Folder 
z Project > Mix Downメニュー    Target Settings > Media Folder 
これらの設定は、後から個別に変更することが可能です。 
 

CDインポート 
Pyramixは、CD素材をメディア･フォルダおよびライブラリーへインポートすることができます。トラックリストやその

他の情報は、オンライン・データベースから自動取得されます。16章：ファイル＆プロジェクト・インターチェンジの

“CDインポート”もご参照ください。 
 

ドラッグ＆ドロップ 
Pyramixと互換のあるオーディオ・メディア・ファイルは、Windowsのフォルダ・ウィンドウからドラッグ＆ドロップで

直接ライブラリー登録を行うことができます。  
  

例： 

Pyramixを起動後、プロジェクトを開いてライブラリーへ移動してください。Windows上のフォルダ・ウィンドウにて

任意のオーディオ・ファイルを選択し、ドラッグ操作でライブラリーへ置いてください。 
 
Note: Pyramixから他のアプリケーションもしくはWindowsのフォルダへのドラッグ＆ドロップは対応しません。 
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ライブラリー 

ライブラリーは、論理的な分類にプロジェクト素材を組織化するのに使用します。 

ライブラリーは、Windowsのディレクトリやフォルダではなく、Pyramix上にて下図のように表示されます。 

ライブラリーは迅速かつ直感的にデータベースへのアクセスできるように設計されたツールです。 

 

Shelves（シェルブス） 

ライブラリーにはサブフォルダ構造のShelf（シェルフ）が作成できます。 

 

Projectライブラリー 

新しくプロジェクトを作成すると、Projectライブラリーも作成されます。 

Projectライブラリーは、プロジェクトと共に保存されます。 

 

Compositionライブラリー 
各プロジェクトには、読み出し専用のCompositionライブラリーがあります。ここには、現在プロジェクトのタイムラ

イン上に置かれているMasterクリップの位置（EDL）がショートカットで示されます。 
タイムライン上に何もクリップが無い場合、Compositionライブラリーには何も表示されません。 
 

Defaultライブラリー 

それぞれのプロジェクトには、Defaultライブラリーに任意の名前を付けてUserライブラリーを作成できます。 
 
 

Globalライブラリー 
Globalライブラリーは、どのプロジェクトからもアクセスして利用することができます。 

効果音などの同一ソースを異なるプロジェクト間で共有するのに便利です。 
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Userライブラリー 
MediaフォルダのMasterクリップは、からUserライブラリーへドラッグすることができます。 

これらは、コンポジション上へドラッグして張り付けることができます。 

 

コンポジション上のクリップやセレクションは、UserおよびGlobalライブラリーへコピー＆ペーストできます。 

ライブラリーに登録したアイテムは、他のライブラリーやShelf，タイムライン上へドラッグ＆ドロップでコピーするこ

とも可能です。このとき、Cut，Copy，Pasteコマンドも使用できます。 
 
Userライブラリーへ登録できるクリップ数に制限はありません。ライブラリーには、コンポジション全体のクリップ，

選択したリージョン，複数のトラックをまたいで選択したクリップなど、あらゆる状態を登録できます。 

選択した情報をライブラリーへ登録するには、ShiftとAltキーを同時に押した状態で、タイムライン上からライブラ

リーへドラッグしてください。 
  

Userライブラリーは、Masterクリップの他にもコンポジション情報，ミキサーのスナップショット，プラグインのスナ

ップショット，フェード設定などの様々なコンテンツを混在させて登録できます。 
  

オートメーション情報 
Edit > Enable Automation Cut/Copy/Pasteメニューが有効になっていれば、クリップにオートメーション情報を

含んだかたちでライブラリー保存できます。 
 
 

Libraryのメンテナンス 
フォルダ移動やバックアップなどでメディアの場所が移動し、参照パスの変更が生じた場合は、Global Libraries
タブ内でDrive > Update Media Pathsメニューを選択すると、Mediaフォルダのパス情報が更新されます。 

  
作成したライブラリー（DefaultライブラリーおよびCompositionライブラリー以外）は、ライブラリー・メニュー上で

閉じることができます。ただし削除することはできません。ライブラリーを閉じたい場合は、任意のライブラリーをク

リックで指定し、Library > Close Libraryメニューを選択してください。ライブラリーを閉じると、Projectライブラリ

ーのリストから削除されますが、Library > Open Libraryメニューで再度開きなおすことができます。 
  

Shelfを削除するには、1つ上の階層へ移動して表示されたShelfを選択でハイライトさせて、右クリック・メニューか

らEdit > Cutを実行してください。 
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実用的なメディアの管理 

Mediaメニュー 

このメニューは、現在のプロジェクトに関連するメディアの管理を行います。 
  

Search Media Search Mediaウィンドウが表示されます。 
  

サーチを開始する前に、検索する場所を指定してください。（１つか複数のLibrary，１つか複数のMediaフォルダ） 
 

 
  

Queryページ 
Queryページでは、Simple Query または Advanced Query の選択できます。 

  
Simple Query 
キーワードを使用して検索を行います。複数のキーワードを入力する場合は、ラジオボタンでOR all words また

はAND all words を選択してください。また、Search only the Name or FileName field または Search all 
text fields も選択することができます。 
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Advanced Query 
Adcancedサーチは、Media ManagementまたはLibraryタブ画面のSearchメニューと同様、いくつかのサーチ・

オプションがあります。ツール＆メニューの章の”Search”メニューに関する記述をご参照ください。 
  
  

Librariesページ 
このページでは、どのライブラリーを検索するかを選択できます。 
z すべてのライブラリーを開く 
z Pyramixのプロジェクトまたはライブラリー・ファイルのリスト 
z Pyramixのプロジェクトとライブラリー・フォルダのパスのリスト 
 
サーチの為にライブラリーを開く必要はなく、パスを入力すれば検索できます。 
 
 
Media Foldersページ 
Librariesページ同様に、Media FoldersページはどのMediaフォルダを検索するかを選択できます。 
z マウントされたすべてのフォルダ 
z パス指定した任意のMediaフォルダのリスト 

リストのフォルダは、Quick Mountライブラリーを介して検索が実行されます。もし、Quick Mountライブラリー

が存在しない場合は、各ファイルのメタデータを参照するか、ファイル名を仕様します。 
  
  

Search Results 
サーチ結果は、Library画面に”Search Results”として表示され、他のライブラリー情報と同様に扱えます。 

  
Mount Referenced Media 現在のプロジェクトで使用しているメディアをすべてマウントします。 
Auto-Mount Media 選択すると、オフラインのライブラリーを参照して現在のプロジェクトへ使

用した際に、メディアを自動でマウントします。 
Select Online Clips タイムライン上で現在MediaがマウントされているOnlineクリップをすべて

選択します。 
Select Offline Clips タイムライン上で現在MediaがマウントされていないOfflineクリップをすべ

て選択します。 
Select Used Media 現在のプロジェクトで使用している任意のクリップのMediaファイルの場所

をMedia Manager画面で開きます。 
Select Media present on 
Project Default Folder 

現在のプロジェクトでProject Default folderから参照しているメディアを

Composition Library画面を開いてハイライトで示します。 
Select Media NOT present on 
Project Default Folder 

現在のプロジェクトでProject Default folder以外のフォルダから参照して

いるメディアをComposition Library画面を開いてハイライトで示します。 
Collect Media to current 
Project Default Folder 

Project Default folder以外のフォルダから参照している（Select Media 
not present ... メニューで検出した）Mediaファイルを、すべてProject 
Default folderへコピーします。 
この機能は、別のスタジオへディスクを移動して作業をしたり、ネッ
トワーク上のリソースを使用したりする場合に便利です。 

Clean-Up Media Choose a Media Folder to Clean-Upウィンドウが開きます。 
クリーンアップしたいMediaフォルダを選択し、OKしてください。 
現在のプロジェクトで使用されていないMediaファイルがMediaフォルダ

内からすべて削除されます。 
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Media Management および Librariesのタブ画面 
Media Managementタブの内容は、メニューおよびツールの内容が若干異なりますが、表示や操作については

Document LibraryやGlobal Libraryタブとほぼ同様です。 
  

Media Browser 
Media Managementウィンドウは、Media Browserとしてローカルまたはネットワーク上のMediaフォルダを参照

できます。 
 

 
  

Media Browser は、Mounted Media Folders の下にツリー構造でディレクトリを表示します。 
 
Media Browser上で認識したMediaファイルは一時的にマウントされ、オーディション再生やタイムラインへの貼り

付けが行えます。 
  

必要に応じて、参照しているMediaフォルダをMedia Browser > Mount Currently Displayed Media Folderメ
ニューを実行してマウントすることができます。 

  
  
  

Document Libraries および Global Libraries 

Global Librariesは、登録したライブラリーがすべてのプロジェクトで利用できます。 
Document librariesとGlobal Librariesに、それ以外の区別は特にありません。 
 
Global LibrariesにおいてDocument librariesのライブラリー・ファイルを開くことができます。 
同じく、Document libraries上でGlobal Librariesのライブラリー・ファイルを開くことも可能です。 
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Default libraryはプロジェクト毎に作成され、Media Filesフォルダ内に自動的に保存されます。 
これらのライブラリー（.pml）は、Global Librariesでも開くことができます。 

 
 
Document libraries タブの左側は、プロジェクトに関連するLibrariesとShelvesがツリー構造で表示されます。 
このリストの中から任意のLibrariesまたはShelvesを選択すると、右側にその内容が表示されます。 

  
Librariesタブでは、右側のリスト内に表示されている任意のコンテンツを左側のツリー階層へとドラッグ＆ドロップ

でコピーできます。 
  

Media Management および Libraryのフィールド 

  
Name クリップまたはMediaファイルの名前 
In クリップまたはMediaファイルのIn TimeCode 
Out クリップまたはMediaファイルのOut TimeCode 
Duration クリップまたはMediaファイルの長さ 
Track クリップまたはMediaファイルのトラック数 
Sample Rate クリップまたはMediaファイルのサンプルレート 
BPS ビット深 
Format ファイル・フォーマット  例：PMF, WAV など 
Creation Date クリップまたはMediaファイルの作成日 
File name （Mediaのみ） Mediaファイルの名前 
Media Size （Mediaのみ） Mediaファイルのサイズ（単位：byte） 
Frame Rate （Mediaのみ） Mediaファイルのフレームレート 
Author 作成者 
Scene シーン 
Take テイク 
Notes ノート 
Tape テープ 
Category カテゴリー分類  例：Master Clip, Media Folder など 
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ツール＆メニュー 

Media Management および Libraryタブ画面には、専用のツール・バーやショートカットがあります。 
 

トリマー 

Media Management および Libraryタブ画面には、Composition/Media Trimmerエリアがあります。 
リストの中からコンポジションまたはメディアを選択すると、下図のトリマーが表示されます。 
 

 
  

トリマーは、Trimmer > Showメニューにより表示／非表示を設定できます。 
リスト内でMediaファイル（またはオブジェクト）を選択するとトリマーが表示され、オーディション再生やトリム編集

を行うことができます。各トラックの左側に表示されている小さな ■  は、トリマー内におけるミュートOn/Offボタ

ンです。左上の ? マークをクリックすると、トリマーに対するコマンド・リストが表示されます。（下図参照） 
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Mediaファイル，クリップ，コンポジションは、下記の方法でトリム編集を行えます。 
 
Double-click Monitorセクションを介して、ダブルクリックした位置からオブジェクトの再生

ができます。 
 
Note: 再生してもモニター出力が聞こえない場合は、Monitorセクション内

のConfigureページにて設定を確認してください。また、“Media Manager
のモニタリング”の章もご参照ください。 

Click & Drag トリマー上で編集したオブジェクトを、タイムラインまたは他のライブラリー内

へペーストします。（リスト上からドラッグした場合、トリム編集の影響なく全

体をペーストします） 
Shift + Click クリックした位置にTrim Inポイントを設定します。 

設定したポイントは、クリック＆ドラッグで簡単に修正できます。 
Control + Click クリックした位置にTrim Outポイントを設定します。 

設定したポイントは、クリック＆ドラッグで簡単に修正できます。 
Control + Shift + Click クリックした位置にSyncポイントを設定します。 

設定したポイントは、クリック＆ドラッグで簡単に修正できます。 
Shift + Alt + Click クリックした位置にTrim Inポイントを設定し、そこから再生します。 
Control + Alt + Click クリックした位置にTrim Outポイントを設定し、そこから再生します。 
Control + Shift + Alt + Click クリックした位置にSyncポイントを設定し、そこから再生します。 
Control + Double-Click Trim In/OutポイントおよびSyncポイントをリセットします。 

  

Trim In, Trim Out および Syncポイント 

Trim In/OutポイントおよびSyncポイントは、Media Management画面でMediaフォルダのリフレッシュや次回の

マウントが行われるまで、Masterクリップの情報として保持されます。 
  

Libraryメニュー 
Libraryメニューは、新たにライブラリーやShelfを作成したり、既存のライブラリーを開いたり保存するために使用

します。ライブラリーを開いた時に、そこで使用されているMasterクリップ/コンポジションが参照しているメディアが

マウントされていない場合があります。（例：リムーバブル・ドライブなど）Mount Referenced Mediaメニューは、

メディアの最新のロケーションを見付けて自動的にマウントします。 
  

New Library 新しいUserライブラリーを作成します。 
Open Library 既存のUserライブラリーを開きます。 
Save Library As  任意のUserライブラリーに新しく名前を付けてコピー保存します。 
Save Library as 4.x 任意のUserライブラリーをPyramix 4.x と互換性がある形式でコピー保存

します。 
Close Library 任意のUserライブラリーを閉じます。 
Mount Referenced Media 現在のProjectで使用しているメディアの最新のロケーションを見付けて、自

動的にマウントします。 
Update Referenced Media 
Paths 

関連するMediaフォルダをすべてマウントし、このメニューを実行してライブ

ラリーを更新します。 
Import OMF library (Avid Bin) インポートしたいOMFライブラリーがある場所をブラウザで開きます。 
Export to Akai DD Series Export to Akai DD Seriesウィンドウを開きます。 
New Shelf ライブラリーまたは任意のShelf内に、新たなShelfを追加します。 
Open Shelf 選択したShelfを開きます。 
Up One Level 1つ上の階層へ移動してリストを表示します。 
Properties 選択したオブジェクトのプロパティを表示します。 
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Editメニュー 
Cut 
（Librariesのみ） 

オブジェクトをカットします。 

カットしたオブジェクトは他の場所へペーストさればければ、削除されます。 
Copy オブジェクトをコピーします。 
Paste オブジェクトをペーストします。 

（Media Managementタブ内には実行できません） 
Paste with Media コピーしたオブジェクトを関連するMediaファイルと一緒にペーストします。 
Rename オブジェクトの名前を変更します。 
Open/Audition/View 
（Librariesのみ） 

選択したクリップまたはコンポジションをトリマー内で開き、オーディション再

生します。または、選択したShelfを開きます。 
Audition 
（Media Managementのみ） 

選択したmasterクリップをトリマー内で開き、オーディション再生します。 

Stop Audition オーディション再生をストップして、カーソルを先頭へ戻します。 
Place Placeダイアログを開きます： 

 
選択したオブジェクトは、ここで指定したルールに基づくかたちでタイムライ

ン上へペーストされます。Syncポイントが指定されていない場合は、Inポイ

ントが先頭になります。 
Placement Tool オブジェクトをペーストするためのPlacement Tool画面を開きます。 
Send （Librariesのみ） 選択したオブジェクトをEメールに添付します。 
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Consolidate 
（Librariesのみ） 

Consolidateダイアログを開きます： 

 
Consolidate機能は、選択したオフジェクトのMediaセグメントをバックアッ

プします。すなわち、コンポジションのクリップが参照しているMediaファイル

のうち、編集して使用している部分のみをバックアップします。 
この機能には、クリップ前後にのりしろを付けられるようHandlesオプション

が備わっています。※Projectのコンソリデートの章もご参照ください。 
Delete Media 
（Media Managementのみ） 

選択したMasterクリップと関連するMediaファイルを削除します。 
※一度削除してしまったMediaファイルは元に戻せません。また、関連する

波形ファイル（.pk）も一緒に削除されます。 
Select All リストに表示されているオブジェクトをすべて選択します。 

Ctrlキーを押しながらクリックすると、複数のオブジェクトを個別に選択でき

ます。 
Invert Selection オブジェクト選択の対象と非対象を入れ替えます。 
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Search 
Search Searchダイアログを開きます。 

 
 上図のフィルターを使用して特定の値を検索できます。 
  

Field 検索に必要なフィールドが登録されており、リストの中から任意のフィールド

を選択できます。 
Not notボタンを押すと、指定したパラメーターを含まないライブラリー・データを

照会します。 
Method フィルター・パラメーターの選択ができます。 
Value リスト表示から選択するか、直接タイプ入力をして値を定義できます。 

リストには、選択されているFieldを参照して、関連するライブラリー内のパ

ラメーターをすべてリスト表示します。 
Recursive チェックすると、ライブラリーのサブ・フォルダを含めて検索を実行します。 
Copy search result in library チェックすると、検索の値に適合したアイテムが“Search Results”として新

たにライブラリーのShelfに追加されます。 
例：Name contains ‘D’ in D:¥Pyramix¥Media 

  
 画面左側のプルダウン・メニューは、AND / ORの選択と共にフィルター条件を追加して設けることが可能です。 
  
  

Viewメニュー 

Viewメニューでは情報をどのように表示するかを決定します。 
 
Toolbar ツール・バーの表示をOn/Offします。 
Status Bar ステータス・バーの表示をOn/Offします。 
Large 大きいアイコンで表示します。 
Small 小さいアイコンで表示します。 
List 一覧で表示します。 
Detail 詳細一覧を表示します。 
Filter チェックすると、Filter Optionsの設定内容に従って情報の表示にフィルタリ

ングをかけます。 
Filter Options （このダイアログは、Edit>Searchと同様の内容のオプションです） 
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Options Library Settingsダイアログを開きます。ダイアログには、下図に示すよう

なGeneralおよびColumnsタブが含まれます。  
  

 
 
GeneralタブはShelfの参照に関するオプションで、Shelfを開くたび新しいフレームを作るかどうかを設定します。 
Columnsタブは、ライブラリーのリストに表示するコラムの設定をカスタマイズできます。 

  
New Window LibraryまたはMedia Management画面を別ウィンドウで開きます。 
Refresh リフレッシュします。 

  

Trimmerメニュー 

Show Trimmerの表示/非表示を切り替えます。 
Show 1 Track Trimmerにオブジェクトの最初のトラックのみ表示します。このオプションを

選択すると、Trimmerトラックの左側に上下矢印（▲/▼）が表示され、トラッ

ク表示の移動を行うことができます。 
Show Track Details 選択されたMediaファイルのトラック情報について、以下を表示します： 

z Track Name 
z Track Number 
z Track Type（left, Right, Center など） 
z Track File Name （One File Per Trackモードで録音され

たメディアのみ対応） 
Auto-Show オブジェクトを選択すると自動的にTrimmerを表示する設定です。 
Auto-Generate Waveform オブジェクトを選択した時に自動的に波形生成を行って、Trimmerを表示し

ます。 
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Media Folderメニュー 

Mount Media Folder 任意のMediaフォルダを参照して、マウントします。 
Unmount Media Folder 指定したMediaフォルダをアンマウントします。 

Refresh Media Folder Mediaフォルダを最新の情報に更新します。 
Create Offline/Reference 
Library 

“Using Offline/Referenceライブラリー”のページをご参照ください。 
 

Create Quick Mount Libraries “Quick Mount”のページをご参照ください。 
Open Folder リスト内で選択したドライブまたはディレクトリーを展開します。 
Up One Level 1つ上の階層へ移動してリストを表示します。 
Mounting Rules Mounting Rulesダイアログを開きます。 

“Mountingルール”のページをご参照ください。 
Properties 選択したMediaフォルダのプロパティを表示します。 

  

 Edit, ViewおよびTrimmerメニュー 

Media ManagementタブのEdit，View および Trimmerメニューの詳細は、先に記述したLibraryメニューと同様

の内容です。以下は、それ以外のメニューについて記述します。 
  
  

 Convertメニュー 

Quick Import Pyramixがサポートするオーディオ・フォーマットの音声ファイルを、任意の

ドライブまたはMediaフォルダへインポートできます。 
  Note: Pyramixがサポートするオーディオ・ファイルは、コンバートなしでインポートして使用することができます。 
  

Quick Export PyramixのMasterクリップを、Pyramixがサポートするオーディオ・フォーマ

ットのどれかに変換して、指定したロケーションへエクスポートできます。 

 
One file per track チェックすると、マルチチャンネルのMasterクリップをトラッ

ク毎にシングルファイルにしてエクスポートします。 
Simple file numbering (.1, .2, .3, ...) チェックすると、シングルファイルの名前に番号を追加しま

す。（.1, .2, .3, …） 
Flatten track numbers チェックすると、ファイル名にトラック番号を追加します。 

（例：1, 2, 7, 8） 
Unique filename extension チェックすると、ファイル名の後に自動的にエクステンション

を付加します。（ファイル名の重複回避） 
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Quick Convert > サブ・メニューに続く方法で、Mediaファイルのコンバートを実行します。 

（下記参照） 
Reverse 選択したクリップの逆再生（リバース）クリップを作成します。 
Export XML Description 指定したメディアの範囲をXML Descriptionとしてエクスポートします。 

  
  
  

 Convert > Quick Convertサブ・メニュー 

 

ダイアログ・ボックス 

 
 
Quick Convertのサブ・メニューは、すべてディスク上に新たにMediaファイルを作成します。どのメニューが選ば

れても、上図のダイアログ・ボックスが表示されます。いずれも、新しい名前を付けたり、既存の名前にサフィックス

を追加することができます。もし、複数のファイルを一回のオペレーションでコンバートする場合、Add Suffixボタ

ンの方を選択すると、OK Allボタンが有効になります。Keep Original File Formatをチェックすると、ファイル・フ

ォーマットはオリジナルと同様のまま実行されます。Properties... ボタンは、各コンバージョン機能に沿った特定

のプロパティ・ダイアログを開きます。 
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Quick Convertの機能別プロパティ・ダイアログ 

 

Resampler のプロパティ 
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このモジュールは、基本的に±0.1％プルアップ/プルダウンのオーディオ変換を行うために使用しますが、定義の

方法（フレームレート，サンプルレート，ピッチおよび％レシオ）によって、多目的にも使用できます。 
 
ピッチの変更をもたらしますが、Time Stretchオペレーションとは異なる処理が行われます。 
入力と出力されるファイルは同じサンプリングレートですが、出力されるファイルの長さは（初期の長さ）×（レシオ）

の結果となります。 
 
Qualityの設定は、オーバーサンプリング処理のトリートメント効果に関する選択です。 
下のグラフは、Quality設定におけるTHD+Nをあらわしています。 
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 Samplerate Converter のプロパティ 

 
z Output Sampling Rate [Hz] から、任意のサンプリング・レートを選択します。 
  
z Conversion Quality を選択します。 

Very high は、より高品質な変換を行いますが処理時間は長くなります。 
  

z Output Wordlength にて希望するワード長を選択します。 
デフォルト設定の32 bits float (SRC internal resolution) あるいは Same as input (includes 
dithering) を選択できます。 
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Prosoniq MPEX3 のプロパティ 

 
 
Stretch または Pitch のオプションの中から必要な設定を選んでください。 
 
Quality Mode および Formant Type の中から適当な設定を選び、MPEX3 Settingsを最適化してください。 

  
Quality Mode Single Instrument Fast 

Single Instrument Best 
Polyphonic Fast 
Polyphonic Good 
Polyphonic Best 

Formant Type Sung Voice 
Spoken Voice 
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TimeZone のプロパティ － Basicタブ 

 
z Scaling は、タイムストレッチの長さを％入力またはスライダーを使用して設定します。 
  
z Quality は、スライダーを使用してHigh Quality（High） および Fast processing（Fast）の間で調整でき

ます。 
  

z Stereo Processing は、ステレオのメディアをアナライズする場合の選択です。 
“Enabled”ボックスをチェックすると、設定が有効になります。 

  

TimeZone のプロパティ － Presetsタブ 

 
ドロップダウン・リストは、様々なサウンドタイプに合わせたアルゴリズムのプリセット選択を提供します。 
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TimeZone のプロパティ － Advancedタブ 

 
 

z Blocklength は、テキストボックスへの値入力またはスライダーの移動によって、ブロック長を32～2048の

間で調整できます。 
 
z Crossfading は、スライダーの移動によってブロック間のクロスフェードの長さを調整できます。 
 
z Energy Detectionは、Enableのボックスにチェックを入れると、-70dB～0dBの間でスレッショルドレベル値

を設定できます。テキストボックスへの値入力またはスライダーの移動によって調整してください。 
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Normalize のプロパティ 

 
  

z Level dBfs 
4つのプリセットから値を選択するか、スライダーを使用して新しいファイルの最大値を設定します。 

 
z Group Normalize 

チェックすると、グループのどのクリップも最大のピークレベルまで引き上げられ、他のクリップと比例したレ

ベルの増加を行います。 
 
z DC Removal 

チェックすると、D.C.オフセットが削除されます。 
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Wordlength Converter のプロパティ 

 
  

z Destination Wordlength 
ラジオボタンを使用して、希望するワード長を選択します。 

 
z Noise Shaping 

ノイズ・シェーピングのクォリティを選択します。 
¾ Hi-Pass 
¾ 8th Order 
¾ 49th Order 

 
Dithering にチェックすると、ディザリングが適用されます。 
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SACDメニュー 

 
  
  

DST Encoder Edited MasterのDSTエンコードを実行します。 
 

 
 
DST Estimator Edited MasterのDSTエンコード化を見積もります。 

ファイルサイズと軽減率をグラフ表示と共に示します。 
 

  
 

Media Browserメニュー 

Mount Currently Displayed 
Media Folder 

Media Browserで参照しているMediaフォルダをマウントします。 
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Mediaフォルダの管理 

 
  

Media Managementタブ画面のMedia Folder > Mount Media Folderを選択すると、上図のダイアログが開き

ます。 
 
テキスト・ボックスにパスを入力するか、ドロップダウン・リストからMediaフォルダまたはドライブを選択します。 
あるいは、テキスト・ボックスに名前を入力すると、新しいMediaフォルダが作成されます。 

  
Permanent Mount 
チェックすると、選択したフォルダは今後プロジェクトを開く際のスタートアップ時にマウントされるようになります。 
サウンド効果のフォルダを使用する場合などに役立ちます。 
 
Quick Mount 
Quick Mountのボックスをチェックすると、システムはMediaフォルダの解析をせずに‘Quick Mount’ライブラリー

をロードします。後述の“Quick Mount”を参照してください。 
 
Recursive 
チェックすると、選択したフォルダをサブ・フォルダも含めマウントします。 
 
Reset Recent Mounted Folders List 
ドロップダウン・リスト内の履歴をクリアします。 
リストには、前回クリアを実行して以降にマウントされたフォルダのすべての履歴が残っています。 
 
Browse... 
フォルダ参照のダイアログが開き、ローカルマシンやネットワーク上のドライブまたはフォルダを参照してOKすると、

テキスト・ボックスにパスがコピーされます。 
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Mount 
選択したMediaドライブまたはフォルダをマウントします。 
新たにフォルダを作成したい場合は、任意のロケーションをパス入力するかBrowse…でロケーションを指定して、

パスの最後に新しいフォルダ名を入力し、Mountをクリックしてください。下図のダイアログが表示されます。 

 
Yesをクリックすると新しいフォルダが作成されます。Noはオペレーションをキャンセルします。 

 
 

Quick Mount 

デフォルトで、Quick Mountモードが設定されています。 
 
通常フォルダがマウントされると、'__QuickMount.pml' と呼ばれるライブラリーがオリジナル・フォルダに登録され

ます。これにより、プロジェクトを開く際にMediaファイルをマウントする時間が劇的に短縮されます。 
 
Quick Mountライブラリーが見つからない場合は、標準のマウントが実行されます。この時、Quick Mountライブラ

リーは新たに作成されます。 
 
Mediaフォルダに何らかの変更があった場合は、次のマウント実行時にQuick Mountライブラリーの内容が上書き

されます。 
 
Media Management および Libraryタブ画面には、専用のツール・バーやショートカットがあります。 
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Mountingルール 

ダイアログは、BWFやWaveファイルを解析する際のルールを示しています。 
 
Pyramixは、マルチプル・モノ・ファイル（A 1-2，A 1-8など）を識別します。 
BWFの場合、EBU組織や様々なメーカー間によって定義されている規定に基づいたBWFヘッダー情報が格納さ

れており、Pyramixはそれを参照します。 
 
これにより、PyramixのMediaマネージャーは規定外とみなされるいくつかのファイルをマウント出来ないことがあ

ります。PyramixのMediaマネージャーは、フォルダをマウントする際にこれらのコンフリクトを検出し、Media 
Manager > Drive > Mounting Rulesメニューを適用するようにユーザーへ通知します。  

  
Mountingルールのダイアログは、様々に異なったルールを容認してMediaフォルダにファイルをマウントする補助

を行います。 
 
コンフリクトが検出されたフォルダは赤く表示されます。 
 
Mountingルールが適用されたフォルダは暗い緑色に表示されます。 
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Mounting Rulesダイアログは、Media Managementタブ画面のMedia Folder > Mounting Rulesメニューか

ら開きます。 

 
各ルールには、詳細な説明が示されています。下記は、ダイアログ左側のオプションについて説明します。 

  

Waveファイルの特別ルール 

Do not validate Wave format Header and allow mounting invalid Wave files (at your own 
risk) 
厳密なWaveフォーマットの仕様に基づいていないファイルをマウントするのに有効です。 

 
Group files with name ending with a surround label (like .L,. C, .R, .Ls, .Rs, .Lf or _L, _C, 

 _R, _Ls, _Rs, _LFE) as a single multichannel media 
マルチチャンネル・メディアのファイル名にサラウンドのラベルを付け、他のDAWとのやりとりに役立てます。 

  

Special rules for Wave files containing BWF or iXML chunks: 
Always use Filename as Media Name instead of BWF Description or iXML Family Name 
これは、Steinberg社のNuendoで録音されたファイルのマウントを許可したり、Aaton社のCantarで作成したファ

イルや他のロケーション用レコーダーで作成したファイルの名前をEDL情報と一致させたりするのに有効です。 
 
Ignore BWF chunk and mount files as standard Wave 
Broadcast Wave（BWF）ファイルのチャンクを無視して、Waveファイルとしてコンファームする助けをします。 
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Special rules for Wave/BWF and AIFF files containing OMF information: 
Never mount Wave/BWF files as OMF 

Never mount AIFF files as OMF 

Show ProTools Wave/BWF files with ‘Enforced Avid Compatibility’ as OMF 
 

オプション 

Also apply this rule to all sub-folders 

Referesh immediately 
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Offline / Referenceライブラリー 

Offline/Reference Librariesは、非常に大きなプロジェクトにおけるトラックの管理や常時オンラインとは限らな

い素材の管理に役立ちます。 
  
  

Offline / Referenceライブラリーの作成 

Offlineライブラリーは、Media ManagementタブのMedia Folder > Create Offline/Reference Libraryメニュ

ーから作成できます。  
 
下図のように「フォルダの参照」ウィンドウが開きます。 

 
  

ライブラリーに含めたいMediaドライブまたはフォルダを参照して、OKをクリックします。 
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次に「名前を付けて保存」のウィンドウが開きます。 

 

新しくライブラリーまたはフォルダを作成するロケーションへ移動し、Saveをクリックします。 

 
 
Create Offline/Reference Libraryのダイアログが開きます。 

 
 Yesをクリックすると、既にライブラリー等で参照しているメディアをフィルターアウトします。 
  

Noをクリックすると、すべてのメディアをインサートします。 
 
 
処理中のダイアログが表示されます。 
ライブラリーの作成を中止したい場合は、Cancelをクリックしてください。 
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ライブラリー作成のプロセスを完了するダイアログが開きます。 

 
 

Yesをクリックすると新しいライブラリーが作成され、ライブラリー画面が開きます。 
 

 
  

Offline/Reference Librariesライブリーの活用 

以下の方法で使用すると、Offlineライブラリーは非常に大きなProjectライブラリー（例：SE素材ライブラリー）を管

理するための強力なツールになります。 

 
メディアのマウント 
Media Managementタブ内において、Audioファイルを含んだすべてのフォルダまたはディスクをマウントします。 
これらのAudioファイルは、長い詳細フィールド，識別子，タイムスタンプ情報を含むPMFあるいはBWF
（Broadcast Wave Format）ファイルを使用されることを推奨します。 

 
初期ライブラリーの作成 
Media Managementタブ内のMedia Folder > Create Offline/Reference Libraryメニューを選択し、All 
mounted Media foldersおよびAdd all Mediaを選択します。これにより、参照しているすべてのAudioファイル

の初期ライブラリーを作成します。 
  

Media > Auto-mount Mediaをオンにしていた場合、タイムライン上へドラッグしたアイテムは自動的にマウントさ

れます。または、マニュアル操作でMedia > Mount Referenced Mediaを選択してください。 
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ライブラリーのアップデート－参照できなくなったアイテム 
もし、オリジナルのAudioファイルを移動したり再編成したりした場合は、再度すべてのフォルダをマウントし直し、

ライブラリーもロードし直し、Update Referenced Media Pathsメニューを選択してください。 
 
ライブラリーのアップデート－新しいファイルの追加 
新しいAudioファイルをメディア・ディスクに追加した場合、それらのフォルダをマウントし、ライブラリーをロードし直

し、初期ライブラリーの作成の工程を行ってください。この時はFilter Media already present in other libraries
のオプションを選択します。 
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